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Welcome to the latest edition of my monthly Final Cut Studio newsletter for May, 2007!

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 150 
tutorials to help you get the most out of Final Cut!

Newsletter Contents

●     Welcome
●     NAB 2007 Report
●     Larry's New Fall Seminar Tour Announced!
●     Getting Organized
●     Last Chance: Growing Your Business Webinar
●     Checklist for an Editing Project
●     Checklist: Dealing with Dropped Frames
●     More on the Life of Digital Media
●     Technique: When Final Cut Pro Won't Open
●     Technique: Durations Don't Match in Viewer and Canvas
●     What's New This Month in Edit Well
●     Deciding Which Training Videos Are Still Worth Watching
●     Technique: Assigning Multiple Audio Tracks to Multiple Outputs
●     Madden-style Telestrating on the Cheap
●     Upgrade Issues with FCP 5.1.2
●     Technique: Deinterlacing Stills
●     Tip: Working with Oversize Photos
●     Comments on Exporting Stills
●     Thoughts on Duplicating Sequences
●     Tip: Shooting DV for HD
●     Tip: Creating Multiple Markers

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/


●     READER MAIL 
❍     Problems with His Girlfriend
❍     Supporting the AVCHD Codec
❍     Timecode Breaks in HDV
❍     Working with PAL
❍     Creating Video for TV
❍     Compressing for Podcasts
❍     Another Idea for Podcast Compression
❍     More Compression Problems
❍     Still More Compression Questions
❍     Creating Good Looking Scrolling Text
❍     Problems Capturing Via FireWire
❍     More Problems Capturing Via FireWire
❍     Ghost Render Files
❍     Dealing with Timecode
❍     Not all Subclips are the Same
❍     It's Not Enough
❍     Archiving Hard Disks 
❍     Show Title Safe Not Showing
❍     Getting Bogged Down with Sequences
❍     Traveling Light
❍     Understanding File Size
❍     Working with Oversize Photos
❍     Avid vs. Final Cut
❍     Avoid "Being Dense"
❍     VideoEGG

●     Wrap-up

Welcome

Well, NAB is behind us with all its news and announcements. More exciting, we have the release of Final 
Cut Studio 2 coming later this month; with Final Cut Server to follow later in the summer.

So, you may wonder, caught between these two monumental events, just what is there to talk about this 
month? Frankly, we have a ton of stuff that 'm looking forward to sharing with you, including a whole flock 
of new tips and ideas that you have contributed.

In the next week, we'll be launching our new store, so keep your eyes open for that -- our new store will 
allow you to write product reviews and give us a lot more flexibility in creating special bundles that can 
save you both money and time.

Also, we have more projects going on here than I can track and I'm looking to hire a part-time person for 
writing and research who also knows Final Cut. If you are interested, drop me an email. It would be helpful 
if you are US-based. 

mailto:larry@larryjordan.biz?Subject=Writer/research position


Remember as you read each issue, that I update it frequently after it's published -- so check back to see 
what comments others have suggested. 

First, though, let's catch up on recent events.

[ Go to Top. ] 

NAB 2007 Report

If you missed my report from NAB 2007 in Las Vegas last month, here it is.

Larry's NAB 2007 report 
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Larry's New Fall Seminar Tour Announced!

With the release of Final Cut Studio 2, we have created an all-new 
PowerUP with Final Cut Studio 2 seminar tour -- 16 cities across 
North America, starting in June!

Because there is so much to cover, we have created three seminars:

●     Picking the Right Hardware (all new!)
●     Optimizing your Editing (revised for 2007)
●     Mastering Final Cut Studio (new for 2007)

Hundreds of editors have taken my seminars and their reviews of wat they've learned have been glowing. If 
you are trying to decide what to buy, how to get your work done faster, or take advantage of the latest 
technology in Final Cut Studio 2 -- you owe it to yourself to take one of my seminars.

●     Click here to read what others have said.
●     Click here to see what each seminar covers.
●     Click here to learn when we are coming to your area.

Best of all, if you register by May 15, you save 15%.

Final Cut Studio 2 has some amazing new features. I'm looking forward to showing you it's secrets. 

Click here to register! 
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Getting Organized for Editing 

Probably the hardest job in editing is getting -- and staying -- organized. Even a small project can generate 
dozens of files, while large projects can require tracking thousands of elements.

A while ago, I wrote an article providing a simple method of file naming and organization that many people 
have found helpful. (You can read it here.)

However, I've often wondered what system other editors use, so last month I put out a call for you to send 
in examples of how you organize your projects. And, boy, did I learn a lot! 

We had contributions ranging from small editing shops up to the BBC, each providing some fascinating 
ideas. Rather than incorporate this whole report into this newsletter, here's a link to it as a separate article. 

Let me know what you like, or dislike, about what you read here and I'll add it as an update.

Getting Organized for Editing 
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Last Chance: Growing Your Business Webinar

Earlier this month, I sent out a notice inviting you to participate in a 
series of live web seminars (webinars) discussing techniques you 
can use to Grow Your Business.

This one-hour live event grew out of a survey we did in January, 
2007, that asked editors what their biggest challenges were for 2007 
-- and "Growing Their Business" was their number one concern.

After several months of research to figure out the best way to 
present this information, we hosted two webinars -- the first session immediately sold out, and the second 
had only a couple of empty seats.

Reviews were universally positive -- but everyone had lots and lots of suggestions. After the first session, 
we completely rewrote the material. After second, we added still more changes. 

We are going to present this one last time - on May 17. Then, we'll take everyone's comments and turn this 
into a DVD that you can play anytime, without needing to be on-line. The DVD will cover sales, marketing, 
handling the competition, and learning more about the strengths of your business.

Everyone attending any one of the three webinar sessions will get this DVD for FREE! 

Please join us on May 17 at 10:00 AM - California time. Our web host only allows 24 participants and we 
have just a few seats left. 

http://www.larryjordan.biz/articles/lj_archive.html
http://www.larryjordan.biz/articles/lj_filenaming.html
http://www.larryjordan.biz/sem/webinar.html


Click here to learn more -- or sign up. Total cost is only $49. All you need is a phone and a browser.
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Checklist for an Editing Project

Thinking about Growing your Business, Paul Chetirkin sent in the following question:

New producers often ask me to send them a checklist of questions that I need answered by 
them to get started on a project. However, I'm new enough at this that I don't know what to 
send them. What do you recommend?

Larry replies:

Here are ten questions you can use to help get you and your producers on the same page:

1.  Who is the audience?
2.  What is the principal message?
3.  How will this program be used by the audience?
4.  What do you want the audience to do once they have seen this?
5.  What would make this a successful project for you, the producer?
6.  How do you intend to shoot this?
7.  What is the final delivery format?
8.  When is the deadline?
9.  Who has review and sign-off authority?

10.  Do you have a budget you need me to stay within?
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Checklist: Dealing with Dropped Frames

There are three questions I get asked all the time:

●     How do I trash preferences?
●     How do I deal with images?
●     How do I deal with dropped frames?

The first two are already covered in articles in my library (Click the question to read related article.) 
However, this last one I haven't really addressed. So, here is a quick checklist you can use to solve a 
dropped frame problem:

1.  Make sure you are not using a hard disk connected using USB.
2.  Make sure your drive spins at least 7200 RPM, many inexpensive drives are slower. 
3.  Don't capture media to your internal boot drive. 
4.  If you are using FireWire drives, make sure your total cable length is less than 15 feet total among 

all devices.

http://www.larryjordan.biz/sem/webinar.html
http://www.larryjordan.biz/articles/lj_trouble.html
http://www.larryjordan.biz/articles/lj_grfx_look.html


5.  Run Utilities > Disk Utility, make sure your capture disk is formatted as Mac OS Extended (see 
this in the Erase tab). Fat 32 is a Windows format and will always cause dropped frames.

6.  Run Utilities > Disk Utility to repair the disk containing your scratch disks.
7.  Do a Safe Boot on your boot disk.
8.  If you own Disk Warrior X, rebuild the disk directories on the disk containing your scratch disks.
9.  If all the prior steps don't work, then trash your FCP Preferences.

UPDATE

Herb Issacs writes:

Why do you say not to use an internal disk to capture? Isn't the internal bus faster than 
firewire input? 

This was amplified by comments from Trent Anderson:

I frequently get dropped frames, and the error message at the bottom in red says, RT 
Extreme has determined that your hard drive is too slow, please increase the speed of the 
hard drive. Well, it is 7200 RPM, and I don't see how I can get a faster one.

I notice that you said to not save to an INTERNAL hard drive. It would seem to me that 
having those things set to an External hard drive, via Firewire, would be even slower than 
going to an internal hd.???

And from Ben Balser:

Reading the newsletter, and in avoiding dropped frames you say, "2. Don't use an internal 
drive to capture media." Why not? It's the most efficient and best method to capture without 
dropped frames. I don't understand why you mention this. There must be something I'm not 
aware of. 

Larry replies: Herb, Trent and Ben - thanks for pointing this out. I stated this poorly. What I meant is not to 
capture to your internal boot disk because it doesn't have the ability to service the operating system, all 
running applications and still feed media reliably over time. It isn't an issue of bus speed, it's an issue of 
contention, rotation speed, and priorities. Complicating matters is that most laptops spin their hard disks 
slowly to save battery life.

An internal second drive is perfectly acceptable.
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More on the Life of Digital Media

Jesse Ritz sent in the following:

We have 1,000+ VHS and Beta tapes, many over 20 years old, prerecorded and 
commercial, mostly because that is what was available at the time. I've transferred Beta to 
VHS, with some loss, LD to DVD (some of those laser disks get worse and worse every 

http://www.alsoft.com/


year; you can see pinholes through the aluminum), and VHS to DVD with no loss that I can 
see on a 32" 480i television. The Beta tapes seem to have deteriorated somewhat over the 
years, but I haven't found a 'two hour' VHS tape that looks any worse than when it was made.

We store all our tapes 'tail down' - that is played straight through without rewinding. We try to 
view every tape within three years but some don't get 're-tensioned' for seven or eight years. 
I don't think that re-tensioning is nearly as important when you store a tape with the nice 
smooth gentle wrap that you get with playing, versus. rewinding. With audio the big problem 
with too tight wraps is 'print through' which you can hear in the leader, or between tracks, 
wearing headphones - the first few few seconds can be heard on the layer just before the 
music starts. Oddly enough you can hear print through on the lead-in of many LPs; from the 
master tapes I presume.

Digital tape storage has its own peculiar problem: bit creep - caused by a whole bunch of 
'ones' being stored in a row; in NRZI recording anyhow. The pressure of each magnetized 
particle causes the bits to drift apart. The problem occurs when they get far enough off that 
they don't align with the rest of the byte. I'm talking about 8 to 64 bit parallel recording.

Moisture and heat are deadly for most magnetic media. I threw away 800 20 year old 
floppies of my brother-in-law that had a tiny dusting of mould in the 'windows' of the floppies. 
On the other hand all of his backup tapes were readable. I transferred them all and scrapped 
the old tape cartridges. The biggest problem with heat that I've seen is my 1976 TR-7's Lear 
8 track tape player. The blasted foam pressure pads all fail within a few years, even though 
it is parked in a garage overnight. You'd think kept out of the sun they'd last longer than two 
or three years, but they don't. I never tried saving the media, I just re-record tapes from a 
new batch of 8 track tapes. (I wish I could find those old beryllium pressure pads.)

Media is a problem too. My step-father in-law insisted on Kodak VHS tapes. I believe they 
are acetate instead of Mylar and they are a mess, jamming, breaking and just plain poor 
recording quality. But the 3M cassette tapes that we bought originally (that was before Dolby 
noise reduction) have all failed, some Fugi cassettes have had the lubricant dry out in their 
tape formula and created horrible scrape flutter. And digital media isn't immune either.

When 1.2 Meg floppies first came out I was called to help a PC technician who had replaced 
a floppy drive twice, the controller twice and a system board. I looked at the back of a few 
floppies that had failed and said "These bad floppies are all Verbatim (brand). The customer 
said "But they are all IBM diskettes." I showed them the Maxell heat seals on the ones that 
were OK and the Verbatim heat seals on all the ones that failed; they inspected every 
diskette that they had. Every Verbatim made 1.2 Meg diskette had errors. But Maxell isn't 
immune to problems, their 1.44 Meg floppies failed left and right when they first came out; 
brutal when you need to restore a 30 diskette backup and RESTORE refuses to continue 
halfway through the restore.

Anyhow, I like tape storage for digital, audio (second to LPs which never deteriorate if you 
don't play them much), and video. Will DVDs last 100 years as they claim? I guess we'll find 
out. The thing is, if my VHS tape gets a few extra dropouts I can still watch it. But a blasted 
DVD just flat stops! And what is worse is watching an analog television picture and having it 
disintegrate into pixels or go black 'cause it is digitally sourced. Don't get me wrong, digital 
broadcasts can be so beautiful that we can see a dramatic difference on our twenty year old 
72" projection TV. Even standard VHS tapes of digital broadcasts (we get 37 channels) look 
great. But digital dropouts are the pits; ain't progress great?



Larry replies: Jesse, thank you for sending all this great information! I'll also add it to our existing article on 
the life-span of video tape.
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Technique: When Final Cut Pro Won't Open

Here's a technique to try when Final Cut Pro won't open.

Many Final Cut Pro plug-ins were written exclusively for the PowerPC processor. As FCP is opening, it 
checks all it's plug-ins to make sure everything is OK. If you have moved PowerPC plug-ins to an Intel/
Mac, FCP will often freeze as it tries to figure out how to deal with these older plug-ins.

The long-term solution, of course, is to upgrade your plug-ins so they support both PowerPC and Intel 
processors. But that won't help you while Final Cut is freezing during start-up. 

What you need to do is remove the offending plug-ins. While deleting them is a permanent, though 
somewhat drastic, solution, all you really need to do is move them where FCP can't find them. Then, later, 
you can figure out which of these is causing the problem.

You will find Final Cut plug-ins stored in:

[Macintosh HD] > Library > Application Support > Final Cut Pro System Support > 
Plugins.

http://www.larryjordan.biz/articles/lj_videotape.html


Open the Plugins folder and drag the contents outside of the Library folder. Final Cut should then start up 
with no problems.

If you want to find out which plug-in is causing the problem, quit Final Cut, then add only a few plugins at a 
time back into the Plugins folder and restart FCP. When it freezes again, the offending plugin will be one of 
the most recently added files to the plugin folder. Keep repeating this process until you find the offending 
plugin(s).
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Technique: When Durations Don't Match in Viewer and Canvas

I ran into this problem recently where I had a clip in the Viewer with a duration of 2:00:00, but when I edited 
it into the Timeline, the duration jumped to 2:00:04.



 

Why didn't they match?

The answer lies in the difference between two different versions of timecode - drop-frame and non-drop-
frame. (You PAL and HD folks can nap thru this discussion -- drop-frame timecode only applies to NTSC 
video.)

First, let's define timecode: it's a label that uniquely identifies every frame of video and/or audio. Timecode 
does not necessarily represent time-of-day. Rather, think of it as a name for each frame -- a name that is 
expressed, not in words, but as a time value.

When television was first invented, all timecode was non-drop-frame. This meant that every frame of video 
had it's own unique timecode label and the timecode value of each frame was exactly one frame larger 
than the previous frame.

The benefit of timecode was that if you knew the beginning and ending timecode of a program, you could 
quickly calculate how long the program ran in real-time.

Life was grand... until color television was invented. The problem with color was that it took 0.03 seconds 
every second to transmit the color information in the signal. While three-one-hundredths of a second 
doesn't sound like much, over the course of a one-hour show, it added up. 

Specifically, it added up to 3.59 seconds (almost a minute and half over an entire day)! Meaning that you 
could no longer count on timecode to provide accurate timing for a show.

Well, this was intolerable. I mean, if you couldn't count on timecode, what could you count on?

So, a new form of timecode was invented: drop-frame timecode.

In spite of what the name implies, NO video frames are dropped using drop-frame timecode. What's 
actually being dropped are some of the timecode labels. Your video is safe -- whew!

The rule of drop-frame timecode is: two frames of timecode are dropped every minute, except on the tenth 
minute, when nothing is dropped. This means that over the course of an hour, 108 timecode labels are 
skipped. The exact numbering goes: 59:28, 59:29, 1:00:02, 1:00:03... (Notice two timecode labels were 
skipped: 1:00:00, and 1:00:01.)

With that as background, you can probably guess the solution. The clip in the viewer was using non-drop 
timecode, while the sequence was using drop-frame.

You can tell what timecode your sequence is using by going to: Sequence > Settings > Timeline tab and 
looking at the timecode check box. If Drop-frame is checked, you are using drop-frame timecode. If not, 
you are using non-drop-frame.



By the way, almost all DV video uses drop-frame. And remember, there is NO difference in quality or 
content between drop and non-drop timecode.
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What's New This Month in Edit Well

Edit Well-- the rich-media newsletter for Final Cut Studio, 
published by Peachpit Press, has the latest news on 
Final Cut Studio 2 -- including over 30 minutes of audio 
interviews with the key product manager responsible for 
the all of Final Cut Studio!

The April issue has the first published "First Looks" at:

●     Final Cut Server
●     Final Cut Pro 6
●     ProRes 422
●     Motion 3
●     and an overview of the announcements on the rest of Studio 2

Plus, we also have articles on:

●     Putting HD Content onto a standard DVD
●     Using Behaviors in Motion

On top of all THAT, we added:

●     35 minutes of audio interview with Richard Townhill, Director, Final Cut Studio Product Manager
●     Audio profile of the founders of the West-of-England Final Cut Pro User Group
●     Video tutorial on adding still images to a QuickTime movie
●     Video tutorial on creating a Compressor Droplet

Edit Well contains the techniques and tips that you just can't find anywhere else. In Edit Well, you don't just 
read about it.. you also watch and listen to it. And, at only $59 per year, this is a GREAT deal!

Click here to view the Table of Contents. Click here subscribe: www.peachpit.com/editwell.

http://www.peachpit.com/editwell
http://www.larryjordan.biz/assets/editwell/ew11_toc.pdf
http://www.peachpit.com/editwell


Edit Well is the perfect compliment to this newsletter -- if you like this newsletter, you'll love Edit Well. (If 
you have any problems subscribing, send me an email.)
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Deciding Which of my Training Videos are Still Worth Watching

I must confess that when Apple announced Final Cut Studio 2, my first thought was -- well, time to create 
new training videos.

And, in fact, Lynda.com and I are already working together to create new material -- more on that in the 
next month or so.

However, not all my DVDs need to be updated. So, if you are looking to improve your skills, and don't want 
to waste your time watching material that may be out of date, here's a list of current titles that will remain 
essentially current with the release of the new versions. 

(I'll provide a list of new titles as they are released later this year.)

• Optimizing and Trouble-shooting your Final Cut System
• Final Cut Pro 5 - Essential Editing
• Final Cut Pro 5 - Color Correction
• Learning LiveType 2
• Soundtrack Pro Audio Filters
• Learning DVD Studio Pro 3 & 4
• Digital Video Principles

My other titles, while still excellent for today's Final Cut Studio, will need to be updated for Final Cut Studio 
2. 

Order one or more titles between now and May 15, and save 15%. (We are clearing inventory and getting 
ready for the new stuff. You might as well benefit, too!)
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Technique: Assigning Multiple Audio Tracks to Multiple Outputs

Normally, Final Cut Pro provides two-channel (stereo) audio output. However, new with Final Cut Pro HD 
was the ability to output up to 24 channels of audio -- if you changed a few settings.

Here's what you need to know.

First, tell Final Cut how many channels you want to output by going to: 
Sequence > Settings > Audio Output tab.

mailto:larry@larryjordan.biz?Subject=Edit Well problems
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From the pop-up menu, select how many channels you wish to output. In this example, I've selected eight. 
(Keep in mind that normal FireWire output is two tracks. You'll need to purchase additional hardware to 
support more than two tracks of audio in or out.)

Then, you choose whether each pair of outputs will be stereo or dual-channel mono. In this case, I selected 
two stereo pairs and four mono tracks. (By the way, unless you are told to change this by someone who 
knows what they are talking about, setting the audio gain of a dual channel mono track to -3dB is correct.)



Once you've told FCP how many audio output tracks you want, you can view them in the audio mixer. 

 

However, unless you have the ability to monitor all eight tracks, you'll only hear the first two when you play 
your sequence. If you want to hear the mix of all your tracks as stereo, click the Downmix button just about 
all the audio meters in the mixer.



Finally, you need to assign each of your audio tracks to an output. To do this, control+click BETWEEN the 
patch panel and the padlock icon for each track. From the pop-up menu, select the output you want to use 
for each track. In this example, I'm outputting audio track 4 to output 4.

One more note, in Final Cut Pro you can't assign one audio track to multiple outputs. One track can only go 
to one output. If you need to send a track to multiple outputs, you need to mix your audio in Soundtrack 
Pro, which can handle this easily.

Creating multiple outputs is useful if you want to save all your tracks as discrete files in a Quicktime movie, 
or you have a multi-track surround mix and want to output each track individually.

The new Soundtrack Pro 2 adds a new dimension to multi-track output with surround sound. But, since that 
hasn't shipped yet, now you know how to handle it in Final Cut Pro itself.
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Madden-style Telestrating on the Cheap

Jim Merrikin contributed this tip.

First I want to thank you for your excellent newsletters and superb video tutorials on Lynda.
com. You have been my foremost guide to getting into the video editing biz and things are 
going quite well, so thank you again!

I am working on several training videos for a large corporate client. The best way for me to 
describe what I am trying to do is to make a comparison to John Madden's style of 
'telestrating' his football analysis with his digital highlighter, drawing circles, lines, arrows, 
and letters. I want to show the animated painting of these characters and objects on top of 
my video footage. I would like to do this in portions of my videos but without a tremendous 
amount of hassle of time. I was hoping to find a 3rd party plugin for FCP or Motion which 
would let me do this but alas, I have come up empty. Do you have any suggestions to point 
me in the right direction?

Larry replies: A simple way to do this is to export a still frame from FCP and move it to Photoshop. Create 
the image you want to reveal as a new layer on top of the sitll frame, then import back into Final Cut and 

http://www.lynda.com/
http://www.lynda.com/


reveal the new layer with a wipe to give movement.

Otherwise, you could do the same thing in Motion by animating a dot along a path to draw your image.

Jim writes back: 

Thank you for the info - you helped me find a great solution. You may want to consider 
sharing this with your other readers since this request seems to pop up more than 
occasionally.

As you suggested, I exported the key still frames from FCP and moved them into 
Photoshop. Then for just $20, I found a product called iShowU from shinywhitebox.com 
which allows me to specify a region on my screen to record 29.97 fps activity. That did the 
trick perfectly. 

I used my Wacom tablet and pen to do the drawing on top of the still frame and had pretty 
much what I needed albeit with a few hundred extraneous frames that I did not need so I cut 
them out in FCP and since the background layer was static, no obvious cutting was 
perceptible. Beautiful! 

iShowU even allowed me to save the recorded movie to QT using the FCP codecs!

Larry replies: Jim, thanks for the follow-up. Also, with the release of Motion 3 later this month, the new 
Paint tool should allow you to do this as well.

UPDATE

Ben Balser contributes the following:

And even easier and more powerful way to do this, is to use Studio Artist. You can use a 
Wacom tablet or your mouse to record LIVE as you draw on top of your still or video image, 
or in a blank canvas. Your selection of textures is beyond what Motion or iShowU can 
provide, and supports all QT codecs installed on your machine. You can save it out as a 
layered still (Photoshop style) or as a QT movie showing you actually writing on the screen 
LIVE. Personally, I think it'd be a more elegant solution than what was suggested. Just FYI.
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Upgrade Issues with FCP 5.1.2

Ben Balser writes:

Here's something I'm coming across more and more. I have a freebie on doing some 
animation tricks with the new FX Plug plugins in FCP 5.1.2 and later. I have had a few folks 
write me and claim that when they upgrade to FCP 5.1.2, on systems with Motion installed, 
the FX Plug plugins are not showing up. Some claim to be upgraded to 5.1.4, and still have 
no FX Plug plugins showing up in FCP.

http://www.shinywhitebox.com/
http://www.apple.com/motion


Any idea what the deal is here?

Larry replies: Yup. The deal is their graphics card. If you have an older Mac that doesn't meet the minimum 
specs for Motion, when you install the 5.1.2 FCP upgrade it won't install the FXPlug filters because they 
require a better graphics card.

You have two workarounds: 

1) Upgrade your graphics card
2) Buy a new computer

Or, just don't worry about it. The new filters are neat, but if you don't use effects much, upgrading may be 
more of a hassle than it's worth.
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Technique: Deinterlacing Stills

Last month, I wrote an article explaining frames, fields, and interlacing. Heidi Stone wrote in with:

Thank you, Larry, for the tip on de-interlacing a still frame. I had a DVD that needed a label 
using a frame from the video. I grabbed a still and imported it into PhotoShop. It didn't have 
a lot of motion, but still had interlace lines of course. I use the PS version of de-interlace and 
realized it had a few more options than FCP. You can choose Odd/Even fields and (the best 
part) Interpolation instead of Duplication. Since I wasn't marrying this image with the original 
footage I don't know if the freeze frame would have looked any better than the FCP image. 
Since I was making the image a duo-tone, it worked just fine for print - and was able to use 
this image for the closing credits as well.

Larry replies: Heidi, thanks for writing!

In NTSC video, fields are shot 1/60th of a second apart (PAL fields use 1/50th of a second). So, when you 
select Odd or Even, you are choosing between the image shot first (Even) or second (Odd).

Because de-interlacing removes every other line, this missing information needs to be replaced by 

http://www.larryjordan.biz/articles/lj_fields.html


something in order for the TV to display the signal. 

Duplication simply doubles every line. This is fast and simple, but it makes your image look soft. It is, 
however, very fast.

Interpolation compares the line above with the line below, figure out what's changed and fill in the missing 
line with it's best guess at what is missing. This tends to be a better choice when you are concerned about 
image quality.

There are also third-party deinterlacers you can buy from companies like: Joe's Filters, Digital Anarchy, 
and Nattress.com.

[ Go to Top. ] 

Tip: Working with Oversize Photos

Edward Julbe writes:

I have a vertical map that I need to show, but when I bring it into FCP, the image is stretched 
out. I need to know how to "constrain proportions" so it doesn't get stretched. I know I'll have 
black columns on the side of map if it's not constrained, but that's fine with me because I can 
fill the background.

Larry replies: Edit the clip into the Timeline, don't just look at it in the Viewer.

Once you edit it, it should be fine. If not, double-click it to load into the viewer, go into the Motion tab and 
adjust scale or aspect ratio (inside Distort) so your image looks proper.

[ Go to Top. ] 

Comments on Exporting Stills

Last month, I reported on a way to export DVCPROHD stills:

Problem: A student recently tried to export some DVCPROHD 720p 24-fps stills from a 16:9 
Sequence in FCP, but they keep getting exported with a 4:3 aspect ratio. What does it take 
to get this to be it's normal 16:9 size?

Answer: Exporting to stills always uses the native size of the media, which for DVCPROHD 
is 960x720 (4:3). The workaround is to export the stills, then set up a still-image preset in 
Compressor and set the aspect ratio to convert it to 16:9 there.

This generated a comment from Robert Garry who wrote in with another suggestion:

Here's another way to export the stills quicker:

http://www.joesfilters.com/
http://www.digitalanarchy.com/
http://www.nattress.com/


Just place them in a timeline that corresponds to your frame size and export using QT 
Conversion. The stills end up exporting in the aspect ratio of your sequence.

Larry replies: Thanks! Keep in mind that using QuickTime Conversion downsamples video to 8-bits, which 
can cause color banding in some video formats. 

[ Go to Top. ] 

Thoughts on Duplicating Sequences

Mio Ristic, from Digital Video Vault in Australia, writes:

I just need one clarification here about "Save As... at the end of each day (covered in: 
Trouble-shooting your Final Cut Pro Project).

I did that once long time ago, and what happened is that I forgot to close the"Saved As" 
version and continued working in that new version. Tomorrow morning I wanted to continue 
working in my original project but then I've got message that some files were missing (I don't 
remember now which files).

Thinking it might be good idea to clarify these steps so that this doesn't happen again. I 
never attempted "Save As" ever again, I was only duplicating files after that.

Now I'm only making copies of projects that might be continued some time in future (like 
some corporate video projects) as I've got Super Duper now.

I'd like to start using "Save As" again as I think rebooting in my back up disc would be too 
much hassle for
such a small issue like going back to yesterday's version of the project.

Larry replies: Mio, thanks for writing.

When you save as, both the old and new project are displayed in the Browser. Close the project you don't 
want to continue using (I would suggest the old one) and continue editing on the newly saved project. 

Duplicating your projects is not as helpful as doing a Save As... When you duplicate a project that has 
problems, you are simply duplicating the problems. Notwithstanding your file confusion, doing a Save As 
actually fixes internal errors before they become severe enough to stop you in your tracks.

My suggestion is to do a Save As every few days to keep your projects error free. Store the old project in a 
safe place. Then, um, remember to open the correct project the next day. 

To make sure you open the correnct project, go to Final Cut Pro > User Preferences > General tab and 
turn OFF "Open last project on application launch." That tells Final Cut not to open any project files the 
next time it is launched. 

http://www.larryjordan.biz/articles/lj_trouble.html
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Tip: Shooting DV for HD

John Warner needed to create an HD sequence, but all he had was an SD camera. So, what did he do?

I just completed a talking head (only in this case a full length body) video green screen 
shoot. I turned the camera on it's side to fill up the HD frame as much as possible (a trick I 
saw somewhere online). 

So now I have 20 clips or so which have to be rotated 90 degrees counterclockwise. I 
decided to open all in Quicktime and use the visual settings under movie properties to rotate 
them. This worked but isn't a pretty workflow. What would Larry Jordan have done?

Larry replies: First, good thinking about rotating your SD camera. While this won't shoot a full HD frame, 
you will still get an image which is 720 tall by 480 wide - which can easily be composited into a 720p frame, 
without needing to scale the image, which would degrade the image quality.

As for solving the rotation issue, I would load all the DV clips into my project. Using the Motion tab, I would 



  
  
  
  
  

rotate the first image 90 degrees. Then, copy the clip using Edit > Copy.

Finally, select all the remaining clips and use Edit > Paste Attributes to paste the Basic Motion setting into 
all remaining clips. I'd have all 20 clips processed in less than 30 seconds.
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Tip: Creating Multiple Markers

John Gallagher contributes the following tip:

I've just stumbled upon a change in the way markers can be added in FCP. When I used 
FCP4.5, you could only ever have one marker covering a section of video. Therefore, ever 
since I have just assumed that it has stayed the same, whilst many times wishing for the 
ability to add "markers within markers" as it were. I just accidentally added a marker now 
over an existing marker, and realized that in FCP 5.1.4 you can add as many overlapping 
markers as you want! Hurrah!



Larry replies: Thanks, John. This is quite cool.
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Reader Mail

Problems with His Girlfriend

Mark Smith, from Cornwall, UK, writes:

Just started out with Final Cut Pro and a small budget video company after a few years 
away from the industry which I love. I used to use an off-line Beta SP suite and have found 
your tips and tricks a real help with getting FCP to do what I have playing in my head.

So thank you very much, I'm very looking forward to spending evenings in reading all the 
back issues on your site; though the cat and the girlfriend might not!

Larry replies: Great. Just what I need -- starting a row about Final Cut between you, your girlfriend and the 
cat. Sheesh...

[ Go to Top. ] 

Supporting the AVCHD Codec

Ted Banucci, from The Last Cut, writes:

I was wondering if you could address the issue of AVCHD and FCP in the next newsletter 
you send out (If it has not been addressed already- I'm a little behind in my reading). This 
codec seems to be making a charge at HDV, and from what I hear, compresses at a better 
rate with a cleaner picture. Although I know this is still a consumer format right now, I'm sure 
it will make it's way into more "prosumer" cameras soon, like HDV did when it initially came 
out. My question is, since AVCHD is based on H.264, Apple's codec, why is FCP (or even 
iMovie) not supporting the editing of it? Is it because of the long-GOP? As far as I 
understand, the only NLE supporting this codec right now is Vegas.

Larry replies: Currently, there seems to be a rush on the part of camera manufacturers to release video 
formats which can not be edited - often for months after the camera's release. AVCHD is one of those 
formats, AVC Intra is another. 

Apple has said they will be supporting AVCHD at some point in the future, but did not express when.

Supporting a video codec for editing requires that Apple's programmers modify Final Cut so that it knows 
what to do with the digital data presented by the codec. Sometimes, that's easy. Other times, in the case of 
HDV, it is very difficult. In no case, however, can you ever assume that simply because a camera 
manufacturer is shipping a camera that the footage it shoots can actually be edited.

http://www.avchd-info.org/
http://www.avchd-info.org/
https://eww.pavc.panasonic.co.jp/pro-av/sales_o/news_info/nab2006releases/nab06_16.html


This points out an increasingly important point -- as editors, you need to get involved in pre-production 
meetings to make sure that the cameras your producers and directors are selecting can create footage that 
can actually be edited.

For a complete list of what Apple supports, click here.

UPDATE

Ben Balser contributed the following thought:

Thanks for making this comment. I fully am behind you on this. As an HVX200 user, I see 
the posts all the time about how this or that NLE is superior overall because it reads "native" 
Panasonic's P2 version of MXF, why FCP won't read it native is bad, etc. Well, most of these 
evangelists (on DVXuser.com, which I've recently abandoned for Creative Cow) think P2, or 
AVCxx, or whatever is the codec their camera uses, it's the only one anyone should use, 
and all NLE's need to "catch up to modern technology" to be professional. Well, not all NLEs 
support the Avid proprietary codec, either. Does that make Avid better? Nope, just different. 
My view is, if a camera maker comes out with a new codec, they are solely responsible for 
its acceptance, not the NLE makers. In the case of my fellow P2 users (who at times go 
overboard with enthusiasm), P2 specific MXF is proprietary, not universal, and no one in the 
world has any obligation what so ever to support it. I like it, P2 makes DVCPRO-HD 
affordable to me, and I have no problems with FCP having to convert it all to QT wrappers. I 
look at the older codecs, they're still around, and much more bullet proof than anything HD. I 
stand my my opinion that HD is a mess, always has been, and will be for some time to 
come. Whatever comes after HD, will come before HD gets anywhere near as standardized, 
as easy to use/access, and as bullet proof as the old original NTSC-DV codecs. As a retired 
IT Engineer in this modern HD world, so much for standards, they don't seem to mean 
anything these days, proprietary is the trend in HD today, from what I can see. But HD 
codecs, there's way too many of them IMHO. HD is a technology that began shipping before 
it was fully developed. 

Larry replies: Ben, I agree. Camera manufacturers seem far more obsessed with carving out marketshare 
with proprietary, and incompatible, codecs than trying to figure out a way for us poor editors to get it all to 
work. I mean do we really NEED over 81 different HD formats? 
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Timecode Breaks in HDV

Bill Roberson writes:

What are the workaround solutions for capture from Sony Z1 that FCP thinks are time code 
breaks?

I have many tapes all shot by a professional that stop during digitizing due to 'time code 
breaks."

http://www.apple.com/finalcutstudio/resources/devicelist.php


Larry replies: As folks who have been reading this newsletter for a while know, I am not a fan of HDV. One 
of the reasons is that it has highly unreliable timecode.

However, what you are seeing may not be timecode breaks. When FCP added HDV capture, it added a 
new feature called "scene selection;" (at least, that's my term). When you shoot HDV, every time you press 
the record button, a special signal is recorded on the tape indicating that the record button was pressed.

By default, during capture, Final Cut senses that special signal and separates each clip into a stand-alone 
file during capture. All other tape formats capture based upon your In and Out in the Log & Capture 
window. HDV captures clips from record press to record press. 

Theoretically, there's a check box in the Log and Capture window for HDV that turns this feature off: 
"Create new clip on Start/Stop." However, in FCP 5.1.2 and earlier, this checkbox doesn't work; or, more 
accurately, it works all the time, regardless of how it is checked. (See the screen shot below.) 

So, in other words, you don't have a workaround.
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Working with PAL

James Calhoun writes:

Now that I've made this nice FCE movie I've dropped it into iDVD to make DVD's of it - but I 
would like to share it with some European friends (in Switzerland) who I think are on PAL 
format as their standard (at least for DVD players - don't know about computer DVD player 
in Europe??).

Do I need to remake the whole thing from the beginning with the default set to PAL instead 
of NTSC? Bummer if so...

Larry replies: Yup. Bummer. Excluding HD, which is a frightful mess all on its own, there are two major, 
and incompatible, video formats in the world: NTSC and PAL. 



NTSC is used here in North America and, with modifications, in Japan. PAL is used everywhere else in the 
world. They have different image sizes, frame rates and an NTSC video can't play on a PAL TV set.

So, you will need to create two different DVDs -- one for North America and one for the rest of the world. 
This will require converting your NTSC video to PAL using either Compressor, or Standard Converter from 
Graeme Nattress. 

Then, you need to design all new menus for your PAL DVD, which uses an image size of 720 x 576, 
instead of NTSC's 720 x 480. Rebuild, retest, re-output, then... poof! Done.

Like I said... bummer.

P.S. I just realized there may be a workaround. Computers are video-format agnostic. Send them your 
NTSC DVD and tell them to play it only on their computer. 

UPDATE

Matt Davis writes: 

Of minor interest: whilst virtually no NTSC player will play PAL DVDs, almost all PAL DVD 
players sold in Europe will play NTSC, as will most TV sets, and most DVD players are sold 
de-regionalized too*. Of course, all PC/Mac DVD players will play both NTSC and PAL 
(though most are NOT deregionalised - go figure).

So when creating a DVD for worldwide distribution, our practice has been to create an NTSC 
(24p) DVD from the get-go (which meant shooting NTSC assets).

Just a view from the UK.

Denis Murphy adds: 

It's the same with NTSC VHS tapes (remember those?) which can also be played in most 
PAL VCRs.

Sometimes the output is in black and white, which happens if the TV doesn't suppport NTSC 
playback fully.

So before you go to the trouble of converting your NTSC projects, you might want to send 
your European friends your original NTSC version and check whether it can be played by 
them.

Larry replies: Cool. I didn't know this. Thanks.
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Creating Video for TV



Louis Tristan writes:

I have a question for you... After creating a final cut pro 5 project how does one save the 
project so it can be viewed on TV...All I know is the iPod at 320 x 240.

But what format is TV? Everything I have done was for the iPod until now...

Larry replies: Louis, you are the FIRST person who has ever asked me how to output to TV. Everyone else 
is trying to figure out how to output to an iPod....

Television requires a video format such as DV-NTSC or DV-PAL. In other words, the normal video one 
shoot's with a camera.

If you are printing to video tape, use File > Print to Video. If you are creating a file to compress onto a 
DVD, use File > Export > QuickTime Movie. The normal image size for DV-NTSC is 720 x 480. DV-PAL 
is 720 x 576. 

The easiest way to get your video onto a TV is via DVD. iDVD is the simplest software to use. Drag your 
QuickTime movie into iDVD and tell it to burn your disk.

UPDATE

Matt Davis writes: 

Check out VisualHub - http://www.visualhub.net

Simple one-click conversion to iPod, iPod/TV output (e.g. 640x480) and the new Apple TV 
specification using H.264 - VisualHub is embarrasingly good, easy and cheap. :)

Larry replies: Matt, thanks for the update.
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Compressing for Podcasts

Ian Hart, from Canberra, Australia, writes:

With regard to Pieter Dekkers' question about compression for Podcasts, I've done a lot of 
experimenting with sizes and compression settings for podcasting recently. My programs 
range from 2 minutes for PR to 35 minutes for educational programs. Exporting from FCP 
5.0.4 to Compressor 2 I've been able to achieve smooth motion, dissolves and wipes and 
even 2 frame cuts, using H.264 at an average bandwidth 1 MB per minute. I find this 
amazing. In fact, if I increase the data rate there is no improvement, if anything the quality 
deteriorates.

Here are the Compressor settings I use (this is for PAL):

http://www.visualhub.net/


●     H.264 512x288 (widescreen) or 640x480 (4:3)
●     Millions of colors 
●     AAC mono 32.000 kHz
●     FPS 12
●     Data rate 130 kbits/sec

Larry replies: Ian, thanks for these suggestions!

UPDATE

Matt Davis writes: 

Working with 16:9 anamorphic, it seems a bit wasteful to simply lobotomise a 4:3 preset. For 
example a 4:3 320x240 movie has 76,800 active pixels in it. A 320x180 16:9 movie, at 
57,600 active pixels, uses the same bandwidth to raise quality a bit, but if the 320x240 is 
acceptable, why not increase the width of the 16:9 movie to 384 pixels, giving 216 pixels 
vertically. Okay, so this movie has 82.9k active pixels over 76.8, but a couple of dozen bits 
per second would cure t hat (ahem) - and hey, see how big and impressive it looks 
compared to the 4:3! :-D (and yes, all divisible by 8).

 4:3 16:9 Use for 

Small
320 x 240 384 x 216 512K ADSL 

Medium 480 x 360 512 x 288 > 512K ADSL 

Large 512 x 384 640 x 360 > 1 Mbit ADSL 

And another I've found is that with more bandwidth and bigger movies on the web, 
deinterlacing traditional video (or preferably switching to a fully progressive system) 
becomes very very important. Thank goodness for the Nattress Gfilm plugin!

Larry replies: Matt, again, thanks for all this good information.
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Another Idea for Podcast Compression

Melissa Dopp, from Pyramid Studios, writes:

In my work I get more demands for Podcasts/Videocasts. Sometimes it involves lectures 
(audio and video) running close to 45 minutes.

I have experimented with various compression settings with very good results. I am quite 
happy with Quicktime Conversion > MPEG-4 > H.264 compression and managed to get 
the file sizes to an acceptable minimum. However when I try to add chapter markers using 
FCP, I have some issues: the chapter markers do not come across in various experiments.

http://www.nattress.com/


The easiest way of doing it is using Garageband. I wonder if Pieter and others might not 
benefit from using ProfCast? I wondered if you felt it was a worthwhile solution?

http://www.profcast.com/public/index.php

Larry replies: Melissa, if you want to export chapter markers, using File > Export > QuickTime 
Compression won't work. If you use File > Export > QuickTime movie, select Include DVD Studio Pro 
Markers, they will be included in your QuickTime movie. Then, drop your QuickTime file into Compressor 
and compress itusing the settings you described. 

This avoids an unnecessary trip to Garageband.

I have not used ProfCast, but am interested in hearing from anyone that has.
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More Compression Problems

Yvan Tirado writes:

Larry, thanks for your Newsletter. It help me a lot. I wanna make a question.

I use compressor to convert a QuickTime movie (NTSC / 29.97 fps / 37 minutes / Default 
Settings in FCP 5.0) into the YouTube format suggested by Brian Gary at
http://www.kenstone.net/fcp_homepage/youtube_compressor_gary.html.

The process took over 2 days. My question is: Why it take so long? Is normal this time? How 
can I improve this process?

Larry replies: Yvan, thanks for writing. 

Brian Gary's article, while detailed, is quite good -- especially given that we have no idea what YouTube is 
doing to our videos.

However, your G-4 is a fairly slow machine and the compression Brian recommends, while not as 
computationally heavy as H.264, still takes time. However, 2 days to compress 37 minutes is a shade on 
the excessive side. 

Recheck your settings against Brian's article. Given your system and assuming all your hardware is 
working correctly, I would expect it to compress 37 minutes of material in less than five hours.
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Still More Compression Questions

http://www.profcast.com/public/index.php
http://www.kenstone.net/fcp_homepage/youtube_compressor_gary.html


Thomas Becker writes:

I have a question for you. I am finishing up a project here for Radar Magazine (a filmed 
photo shoot) and am going to put it online tomorrow or the beginning of next week. They've 
asked me to put a slug/watermark on the entire video. Is there a simple way to have the psd 
file onto the entire sequence? I just made half-hearted search on your site for the answer but 
didn't see anything. Anyway, I hope you can help. Thanks a mil.

Larry replies: Yes -- the easiest way is to use Compressor.

Go to the Filters tab, scroll to the bottom and use the Watermark filter. The watermark is added during 
compression, which saves you rendering time in Final Cut Pro. 
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Creating Good-Looking Scrolling Text

Edward Julbe, of Miami/Dade Fire Rescue, writes:



I am doing some full-screen CG work in After Effects (version 6.5 pro bundle) and exporting 
it out as a QuickTime file. When I import that file into FCP (version 5.1.2) and load it into the 
Viewer, as I've done a million times before, it plays back fine. However, when I add it to the 
timeline and render it out, things go haywire! The playback of the QuickTime file blinks like a 
strobe effect has been added to it....

Until now, I had been using the Animation codec, and this was the one giving me problems. 
Since everything I shoot is DVCAM/Mini-DV, I switched to the DV codec in AE. The flickering 
is gone, so that's the good news. The bad news is that I still see a lot of interlacing artifacts 
in the text that's animated (during its motion). It looks fine when it "lands" into its final 
position. Will I get better results if I just stick with LiveType and/or Motion?

Larry replies: Edward, the problem isn't the codec or where you are creating it, necessarily. What you are 
seeing is that video always displays moving images interlaced, while the computer displayed them 
progressively.

(Here's an article you can read that describes the differences.)

When creating scrolling text, you can minimize the flickering by adjusting the scroll speed. Some scroll 
speeds move text such that they roll in sync with the interlace. I spent some time browsing the web to see 
if I could find an article that I read recently that describes how to set the right speed, but couldn't find it.

The best thing is to create your scroll, then adjust its speed slightly (small changes are best), while looking 
at it on a video monitor. Pick the speed that looks smoothest. If you use the same font size, you'll be able 
to use this same scroll speed setting across multiple projects.

UPDATE

Andrew Wilson provides the following guidance:

Just finished reading this month's newsletter and I might finally have something useful to 
add...

I know it's not possible in Final Cut but whenever I'm creating scrolling text, I use After 
Effects. Twirl down the speed triangle under position and adjust either the duration of the 
scroll of the beginning and ending keyframes so your speed is 59.94 pixels per second 
(29.97 x 2). Also make sure that your vertical position on both your beginning and ending 
keyframes is set to an even number and your point size is an even whole number. This 
should greatly reduce the font's top and bottom flicker when output NTSC. I've also had 
better luck using sans-serif fonts.

This is of course assuming you're producing scrolling credits for NTSC Standard Definition 
video.

Larry replies: Andrew, thanks for this tip. 
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Problems Capturing Via FireWire

Last month, Jay Moy wrote in with a question:

I'm trying to capture from a Canon MV890 camera. When my external drive is connected, I 
can not capture footage, but I can control the deck and see timecode. The deck is connected 
via FireWire into the back of a 500GB G-Tech drive which is connected into a 17" MacBook 
Pro via firewire 800. The problem is the same if I connect the camera into the firewire 400 
port on the mac - when the external drive is connected i cannot capture footage, but i can 
control the deck and see the timecode.

Larry continues: At that time, I couldn't think of an answer, so I opened the discussion up to everyone. 

First, Steve Eisen wrote in:

In response to Jay's question. I believe the problem is that on both the MacBook Pro and 
Tower, all FireWire ports are located on the same bus. Certain cameras and decks (Canon 
in particular) have problems when more than one device is attached to the firewire ports. To 
solve the problem, a second firewire card is required.

This was echoed by Gary Gowman:

It is my understanding that Macs have one FireWire bus even though they have more ports 
on the outside for connection. So, when you connect an 800 device and a 400 device, they 
both operate at 400 on the one bus they use. Also, in the past I have always heard that you 
need two FireWire busses when a camera and an external hard drive are connected on this 
one FireWire bus seup or else you will get dropped frames. He needs to capture to the 
internal hard drive or add a second FireWire bus using the laptop express card slot. 

Larry replies: Steve and Gary, it's true that the Macintosh puts all FireWire ports onto the same bus. This 
can cause slow downs in speed, especially for FireWire 800 drives, because the speed of the bus is 
determined by the speed of the SLOWEST device; generally this means the camera or deck. Adding a 
second FireWire card to your system can solve this problem.

However, I have not heard that a particular camera, or brand, is especially susceptible to this speed 
slowdown.

Additionally, dropped frames are most often caused by a hard disk that's too slow. While data drives rarely 
get corrupted in Unix, it can happen. Also, if a drive gets too full, it slows WAAY down. You can alleviate 
this problem by making sure to keep about 25% of your drive space free, and periodically running Disk 
Utility > First Aid > Repair Disk on all your data drives. 

Above all, I STRONGLY recommend against capturing video to your internal drive.

Then, Gregg Hurrell, from WaveMaker Productions, wrote in saying:

This sounds like a Quicktime problem, try downloading and re- installing QT this could solve 
the problem.

Larry continues: Gregg, thanks, this could also be the solution.



However, in thinking about this further, and a bit removed from the pressure of a deadline, I realized there 
might be something more serious involved here. So I went to Apple's website and discovered the Canon 
MV890 is not a supported camera' which explains why it doesn't work.

If you want to see if a camera you own, or are thinking to buy, is supported, here's where you need to go: 
http://www.apple.com/finalcutstudio/resources/devicelist.php

UPDATE

As usual, Uli Plank knows more about this than I do, so here's his comment:

Unfortunately, [regarding your comment about FireWire problems with Canon cameraa] 
there are problems. Canon cameras are notorious for bad implementation of the FireWire-
protocol. We have quite a few Sonys and Canons in our department, and while the Sonys 
even work when daisy-chained through a FireWire drive, the Canons act up frequently even 
when they are all alone on the bus.

Larry replies: Uli, thanks for the update. I stand corrected. 
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More Problems Capturing Via FireWire

Michael Grenadier writes:

If you are having problems capturing your video into Final Cut Pro, try setting your Device 
Control (Final Cut Pro > Audio/Video Setttings) to FireWire Basic.

If that doesn't work, get a FireWire card for the MacBook Pro. Having your drive and capture 
device on separate busses is the "almost" guaranteed solution. If I remember correctly, the 
card's around $80. I've got one for my MacBook Pro.

Larry replies: Thanks, Michael. Good cards to look at include: Caldigit and Sonnet. 
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Ghost Render Files

Lucy Neil Stewart writes:

Hey, you ever get keyframe(center/motion tab) ghosts where the clip remembers where it 
went before after you've changed the numbers? I fixed the problem with more keyframes..
but after all the work I've done, I never remember this happening and I have GREATLY 
reduced the number of layers and effects I am working with now... interesting anyway.

http://www.apple.com/finalcutstudio/resources/devicelist.php
http://www.caldigit.com/FASTA-1ex.asp
http://www.sonnettech.com/product/tempo_sata_express34.html


Larry replies: Sometimes FCP does not properly get rid of render files. To solve this, select the offending 
clip and type Control+B. This makes the clip invisible. Then type Control+B again. This makes the clip 
visible -- BUT this procedure also deletes all the render files associated with that clip.

See if that fixes the problem.
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Dealing with Timecode

James Wicks, of Wicks Films, writes:

Can you help me solve an issue? I just re-read your article on timecode.

I want to add a timecode reader to my timeline, but have it begin at a specific time.
Following the example in your article, the timecode reader begins at zero.
What if you wanted TC to begin at 10:00:00:00 instead?

Larry replies: James, here are the steps:

1.  Create a new sequence.
2.  Drag your old sequence, that you want timecode for, into the new sequence.
3.  Apply the Timecode Generator to the entire sequence contained in the new sequence.
4.  Option-Double-click (or drag) the old sequence to load it into the Viewer.
5.  Change the hour offset to 10.
6.  Output

James wrote back:

That works, but if all you want to do is put timecode on a single clip, there's an easier way:

All you have to do is modify the clip’s timecode. Modify > Timecode > input the numeric 
value of your choice.

Add the Effects > Video Filters > Video > Timecode Reader to the clip or nest ...and it’s 
done. Works like a champ.

Larry replies: James, that's a good solution. Keep in mind that when you change the timecode of a clip, it is 
a permanent change that is recorded in the media file on your hard disk. This means that if you are using 
paper logs, or every need to recapture media from the source tapes, the timecodes in Final Cut won't 
match.
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Not all Subclips are the Same

http://www.larryjordan.biz/articles/jr_timecode.html


Roland Coburn, from Manchester, UK, writes:

As one of the lucky punters who was able to attend your PowerUP seminars in Manchester, 
England, I know you will be able to answer what you would call a "Simple Question":

I have to re-edit my programme (Producer changed their mind, again). I seem unable to 
make a duplicate of my show to keep as a reference or use as a source.

The main problem I have is when I make a subclip (Edited sequences ) to save for later, 
when edited back into my new timeline it comes across as one large clip with no edit points 
and all the sound mixed.

Is there a way of editing subclips back into my timeline complete with all the viewable edits 
with split tracks? Sorry to trouble you but this is becoming a real bore.....

Larry replies: First, I would just duplicate your edited sequence in the Browser to keep a copy of the 
existing edit.

However, iIf you feel that subclips are your best choice, remember that when you create a subclip of a 
CLIP, it has all the characteristics of the clip.

If you create a subclip of a SEQUENCE, it has all the characteristics of the sequence, including audio 
outputs that you defined for it.

The work-around is to drag your sequence subclip into the Timeline then, AFTER your cursor enters the 
timeline window, hold down the Command key. 

Voila! Instant deconstructed sequence subclip.
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It's Not Enough

http://www.larryjordan.biz/sem/2007_fall.html


Anne Farrell revisits an old issue:

I love your newsletter but I wish you'd correct your use of the possessive and the elision, 
"its" and "it's."

For example
"This article got it's start in an email from a reader..." Reads as "This article got it is start in 
an email from a reader..." Obviously awkward.

• It's = it is
• its = possessive.

Hope this is helpful.

Larry replies: Anne, you join a long list of readers who have tried to pound this into my head. I don't do it 
intentionally, but I seem congenitally unable to remember this. Thanks for pointing it out.
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Archiving Hard Disks

Lenny Levy writes in with a question I need some help with:

I don't know if this is the proper forum for this question, but I have never seen an article or 
any information on the best ways to store your drives if you are using hot swap enclosures.
I have a hot swap 2 SATA enclosure and am concerned about what to do with these extra 
naked drives I've got laying around now.

●     Should they be in static free bags?
●     Wrapped in bubble wrap for protection?
●     Are there holders of any kind that protect them form physical and/or electronic shock?
●     Should you just stack them on a shelf?
●     Little cardboard boxes?
●     Does anyone make a storage rack for shelves?

Especially now with the P2 systems people will be storing more and more drives instead of 
tapes and its cheaper to go with hot swap enclosures.

Larry replies: First, I'm not a fan of using hard drives for long-term storage.

Second, as I don't do this myself, I asked readers to contribute their ideas and I was surprised at the range 
of suggestions.

UPDATE

Kevin Brumfield writes:



A quick suggestion for Lenny Levy and his "naked drives" problem: Try storing these drives 
in VHS cassette cases. This makes archiving and storage very easy. Kudos to Joel 
Peregrine who originally suggested this to me.

Gary Gowman contributes the following thoughts:

I am not an expert on this, but common sense makes me believe that you treat the drive like 
anything else of importance. Such as tape or film where you should always control the 
storage area for heat, cold, humidity and clean air. The static-free bag, like the one a new 
drive comes in, makes sense to me. Also, keep the room at normal living temperatures with 
a low humidity. Maybe even add those little packets that we always see in packages of new 
equipment that I believe are put there to absorb humidity. If you stack the drives on a shelf in 
a static free bag, it might be wise to add a good piece of strong cardboard between the 
drives to protect the one side that has its electrical components exposed. Or, use a full 
cardboard box with a decent thickness for all around protection. Don't forget the usual 
chores of keeping a room clean with periodic cleaning, dusting and sweeping.

I wonder on how a hard drive would perform, say three or more years later, after sitting 
there. Is it like a car where you should take it out for at least a spin every few months?

Larry Krantz supplied a suggestion for a container: 

I was reading your newletter and the article on SATA drives laying around on shelves. We 
use them but keep them in their frames and in these cases from WeibeTech. The frame and 
case add about 50.00 to the cost of the drive but worth it. The cases we store in a secure 
container. Plus we keep a duplicate of each SATA at our off-site storage. From reading your 
article, I am going to add a third backup measure and that will be to use DLT in addition. 

Ben Balser offered a technical perspective:

I approach this as an IT Engineer with all those years of professional experience designing, 
installing, and maintaining enterprise level and Internet systems from Canada to Puerto 
Rico. 

You are correct, hard drives on a shelf are the WORST long term storage solution. The 
material on the platters can be thought of as similar to the material on tape. Age will cause it 
to break down and fail, just by sitting there. Since drives also have moving parts, those parts 
when not in use tend to degrade. A hard drive is designed to run, running keeps it healthy. 

I've seen companies try [to archive media on hard disk] over my professional years in IT. I've 
seen them pull drives several years old that simply won't boot up. Data was unreadable, or 
the mechanics just didn't work properly and the drive was dead. They went bad just sitting 
on a shelf. IF you have old drives you want to keep with NO DATA ON THEM, that's fine. 
Place them in static proof bags like they came in, and store them in a cool, dry place, be 
sure they aren't going to get bumped a round, that's it. But those old drives still won't last 
long term in a closet, not reliably, not for more than a couple of years or so. \

This is a major concern for those of us who've gone tapeless. DLT drives have been around 
since the first IBM Big Blues (which I cut my technician teeth on using a voltmeter and 
soldering iron), and are by far the most proven and reliable long term archiving solution. 
These tapes are made for archiving, made to last a very long time, and they do! They are 

http://www.weibetech.com/products/cases.php


much higher quality (thus more expensive) than Mini-DV tapes. Someone once asked why 
no one has come up with a way to use Mini-DV tapes just like DLT's for archiving. The 
answer is, Mini-DV has too short of a life span to be reliable enough for long term archiving.

Larry replies: Ben, thanks for this update. I am VERY wary of recommending archiving hard drives. You've 
just given me more reasons to suggest that tape-based archiving is the only reasonable archive solution at 
the present time. 
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Show Title Safe Not Showing

Alex Pushkin writes:

How come in the Canvas "Show Title Safe" is not highlighted? I can't activate it.

Larry replies: In order to see Title Safe areas, you also need to check "Show Overlays" just above it. Both 
need to be checked for Title Safe to be visible.
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Getting Bogged Down with Sequences

Eric Hvsic writes:

In your last newsletter you had a section called "Be Careful of Too Many Sequences" by 
Jack Freidog. It was a big eye opener. It explained why I was getting bogged down with the 
"preparing video for display code." My problem is that the way I work demands lots of 
sequences, 50 to 60 at least. so how can I get around this limitation? Do nested sequences 
count ?

Larry replies: Nested sequences count.



●     First, keep as few sequences open in the Timeline as possible. Sequences in the Browser take up 
FAR less memory than sequences in the Timeline.

●     Second, trash any sequences in the Browser that you don't need.
●     Third, FCP 5 is MUCH better at handling this than FCP HD.
●     Fourth, add more memory, though 4 GB is the current maximum limit of system RAM that FCP 

supports. This memory limit will increase with the release of Final Cut Studio 2.
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Traveling Light

Stanley Dumanig, from the Philippines, writes:

I got an iMac Core 2 Duo with a 320GB Firewire hard drive attached to it in my office and 
currently I bought a MacBook Pro(MBP). I mainly use the iMac for video editing but since I 
now got a number of clients/projects I'm working more than 12 hours a day. In view of this, I 
just want to work 8 hours in the office and continue to do the work if needed at home with my 
MBP.

What is the "best workflow" to get the project files off my iMac to my MBP? I implemented 
your file naming convention and indeed I can easily copy the project files to my MBP and 
bring my Firewire hard drive and continue to do the work at home. However, can I possibly 
leave the hard drive in the office and just get the clips in my sequences to my MBP? I 
desired to finish the story board at the office and work on transitions and effects at home. Is 
this possible without grabbing my Firewire drive at home?

Larry replies: The short answer is No.

Final Cut is storing all your media on the second drive. This means that in order to see your media, you 
need to bring the second drive home along with your computer.

Because video files are very, VERY big, they can not be reliably accessed using just the internal drive of 
your laptop. You will end up with significant numbers of dropped frames. While you could convert your 
video to a smaller format, say Motion-JPEG, and store them on your internal drive, this would then require 
up-conversion prior to final output, which is a lot of extra work.

In general, it is good practice to use two drives for video editing -- one for media and one for everything 
else.
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Understanding File Size

Wes Brown writes:

Can you tell me why when I export a QuickTime movie my files are coming out so large 



(20GB for 90 minute video)?

I exported several Quicktime movies earlier this year and they are all around 1.25 GB. I have 
not changed any setting that I am aware of. Should they be a great deal smaller as an 
exported Quicktime movie?

Larry replies: When you export a self-contained QuickTime movie, the size is 13 GB 
per hour for DV. When you export a reference QuickTime movie (which can ONLY be played 
on your system), the size is about 700 MB per hour.

The difference is checking the "Make Movie Self-Contained" box in the QuickTime export dialog.

There are only four reasons to export a self-contained movie:

1.  You want to give the file to someone else 
2.  You want to store the file on your system for a long time
3.  You are working in HDV
4.  You are trying to solve an output problem.

If one of these four reasons does not apply to you, you are better off creating reference QuickTime movies. 
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Avid vs. Final Cut

Dejan Savic provides the following suggestion for Avid editors moving to Final Cut:

By the way, I recently purchased your Final Cut Pro 5 training book, and I really find it 
outstanding. I've been working as an Avid editor for years and your approach makes it very 
easy to make the transition.

Maybe there is one thing that I wish I had known right from the start: that each FCP 
sequence has its own settings (whereas with Avid, each project has its settings, which are 
then applied to all the sequences it contains). It took me some time to figure out why certain 
QuickTime clips played flawlessly in the FCP timeline, while other needed to be rendered. It 
turned out that I had to tell FCP which codec I wanted to use for each sequence. 

Many FCP editors I know encounter the reverse problem when they have to edit with Avid 
systems, so it could be worth mentioning the difference between the two. 

Larry replies: As someone who has never edited on an Avid, I'm especially grateful for this tip. Thanks for 
sending it it.
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Avoid "Being Dense"



John Gallagher, who seems to write more of these tips than I am this month, contributed one more:

When executing the Match Frame command (put your playhead in a clip and press "F") on a 
clip in the sequence, make sure the playhead is over a frame. This may sound obvious, but 
if the playhead is at the end of a sequence, it won't be over a frame because of the way 
Final Cut handles in and out points. You'll need to move the playhead back a frame, so it's 
actually over a frame of video. I made this mistake several times before I realized Match 
Frame wasn't broken, I was just being dense!

Larry replies: John, thanks for writing -- and for your superb write-up on getting organized. The blue vertical 
bar on the right side of the Canvas indicates that you are past the end of your sequence. As long as your 
playhead is inside a clip, the Match Frame (press F) will work.
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VideoEGG

Ross Pappas sent in the following:

By the way, thought I’d mention something you might want your subscribers to know about.

There’s a fantastic web site called videoegg.com. Via the browser (with Macs this only works 
with Safari), you can drop your video file onto their interface within the browser, converts it to 
flash, and uploads the file to their server. The conversion is done for you, they host the file 
free, and the page is without clutter. They also give you html code to copy and paste onto 
your site. A fantastic service for anyone wanting to put their video files online, its a much 
better alternative to YouTube, considering the encoding is done for you, it’s like a one stop 
shop, and it’s free. 

Larry replies: Ross, thanks for sharing this.
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Wrap-up

Well, that's it for another issue. Please take a few minutes and:

●     Sign up to attend our Grow Your Business webinar. 
●     Subscribe to Edit Well
●     Visit our store and buy a DVD, or two. 

Your support for our seminars and products keeps our website, and this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share your ideas 

http://www.larryjordan.biz/articles/lj_filenaming.html
http://www.videoegg.com/
http://www.larryjordan.biz/sem/webinar.html
http://www.peachpit.com/editwell
http://www.larryjordan.biz/store/index.html


and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 
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